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Collaboration 9.0 v2 

Cisco Unified Attendant Console Enterprise Edition / 

Cisco Emergency Responder 
·最近更新：2013-07-08 

 

关于此思科演示 
此预配置演示包括： 

· 此脚本情景演示 Cisco Unified Attendant Console Enterprise Edition 如何为控制台操作员提供一种快速接收并有效区分接

入电话的工具。 

· 此脚本场景演示 Cisco Emergency Responder 如何确保紧急应答机在接收到现场人员报警时能够准确定位并向 911 求助 

· 管理层通过按客户要求定制演示环境以模仿用户环境。 

 

演示要求 
下表列出了本预配置演示的设定要求 

表 1：演示要求 

必备 可选 

● 路由器、已注册并已为 dCloud 配置 

● 笔记本电脑 

● Cisco Unified IP Phones 

o 6941 

o 9951 

o 9971 

 

演示配置 
该演示包含预配置的用户和组件，图解 Cisco Unified Attendant Console Enterprise Edition Collaboration 9.0 v2 解决方案的脚本情

景和特征。完成演示场景所需要的所有信息都在你现演示的 Topology 和 Servers 菜单中。 

 Topology Menu. 点击拓扑中的任何服务器，弹出窗口会出现可用的服务器选项。 

 Servers Menu.点击任何服务器旁的  或 键，显示可用的服务器选项和认证信息。 

 

表 2：预设置的用户信息 
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用户名 用户 ID 密码 角色 端点设备 电话 分机 

Adam 
McKenzie 

amcken
zie 

C1sco123
45 

 

控制台操作员 

在场安全应答员 

9971 

Workstation 1  

+1 408 555 6016 6016 

Anita Perez aperez C1sco123
45 

911 呼叫者 9951 

Workstation 2 

+1 408 555 6017 6017 

Charles 
Holland 

cholland C1sco123
45 

911 操作员 6941 +1 408 555 6018 6018 

 

演示配置 

演示前 

我们强烈建议，在您将这演示在现场观众前，必须至少检查一次此全过程。这将让您熟悉文件的结构和此演示。  

准备工作是一个成功顾客展示的关键。 

按照下面的步骤安排您的演示并配置您的演示环境： 

1、注册并配置您的端点路由器，如果这是您的第一次，请使用您的 dCloud 路由器。 

2、安排一个演示； 

3、在执行任何演示场景前，测试你演示现场的宽带； 

4、验证你的演示在 dCloud UI 中 My Dashboard 页面下的 My Demonstrations 的状态为 Active； 

·这个过程大概要占用你 30 分钟，您的演示将开始运行。 

5、在您的笔记本电脑上安装并访问 Cisco AnyConnect，在 dCloud UI 里使用 AnyConnect 认证； 

6、连接您的路由器和笔记本电脑； 

7、使用您当地的 RDP 程序或 WebRDP 访问并登入演示工作区； 

8、通过 RDP 登入演示工作站 1 

 工作站 1 (198.18.133.36), 用户: dcloud\amckenzie, 密码: C1sco12345 

 工作站 2 (198.18.133.37), 用户: dcloud\aperez, 密码: C1sco12345 

9、准备将要在演示中用到的电话，使用演示工作站 1 的电话配置工具（ Phone Provisioning Tool）或者直接登入 Cisco Unified CM 

Administration 的主页； 

 Adam McKenzie: 9971 

 Anita Perez: 9951 

 Charles Holland: 6941 

10、将统一的 IP 电话 9971 与 CUACEE 应用程序联系起来； 

a、在工作站 1，启动网络搜索并浏览 Collaboration Admin links > Cisco Unified Communications Manager. 使用以下认证登录 

Cisco UCM: 用户名: administrator, 密码: C1sco12345. 

b、选择 User Management > Application User.  

c、通过以下搜索标准定位 cueac 程序用户，并点击 Find.  

 

d、在搜索结果中点击 cueac 用户 ID. 

e、在应用程序用户配置窗口，向下滚动到设备信息区域。 

f、在可用设备栏，定位 Adam McKenzie 的电话。设备名称的格式为：SEPXXXXXXXXXXXX，即设备名称均已 SEP 开头，剩下的

内容是该设备的 MAC 地址。 



  

 
© 2013 Cisco and/or its affiliates. All rights reserved. This document is Cisco Public Information. Page 3 of 13 

·选中该设备并点击 向下的箭头，将设备添加到 Controlled Devices 列表中并点击 Save.  

·退出 Cisco UCM. 

·关闭网络浏览器。 

11、当你启动 Cisco Unified Attendant Console Enterprise Edition 时，会被提示正在运行一个评估副本，点击 OK 继续。如果你想将演

示延伸至 5 天以外，在许可证过期之后就需要重新启动服务器。详见附件 A. 
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场景 1：话务台 
此演示场景描述了一个视频设备制造公司如何使用 Cisco Unified Attendant Console Enterprise Edition 高效处理接入的电话。 

演示步骤 

步骤 要点 操作 

1 我叫 Adam McKenzie，是一个视频设备制造公司的

控制台操作员。让我来告诉你如何处理我们业务上

接入的电话。我的一天从登陆 Cisco Unified 

Attendant Console Enterprise Edition 的客户端开

始。 

·在工作站 1，从桌面快捷方式启动 Attendant Console。 

·点击 File > Login，输入用户名 OP1 和密码 C1sco12345. 

·确认电话分机设定为+14085556016. 

·点击 Login。 

2 
我在控制台上看到的电话薄与 UCM 定期进行同步通

信，任何该电话薄下的用户都必须是 UCM 的终端用

户。 

作为操作员，我可以在每个联系人上添加额外信息

（如工作职务、地点、注释，可选择的联系号码

等）。 

由于信息是储存在 Cisco Unified Attendant Console 

的服务器上的，所以一个操作员上传的信息可以立

即被所有操作员使用。 

强调：Cisco Unified Attendant Console Premium 

Edition 支持与活动目录同步——这极大程度地方便

了在电话薄上自动添加更多信息。 

 

·使用 Last Name 搜索框，开始打名字 Adams。 

·右击联系人，选中 Contact > Contact Details 或按 F12。 

·灰色区域会通过 UCM 填充，这些不能在 Attendant Console 电话薄

内更改。 

·注意你可以输入信息的其他所有区域。 

·点击 Alternate Numbers，并点击 Add，将一个联系人添加到

under Assistant 或 Alternate 下。 

·点击 Notes，将一些注释添加到 Contact Information 或 Contact 

Absent Message, 点击 OK.  

·在该电话薄下，你将会看到带有一个红色箭头和一个注释图标的联

系人。将鼠标悬停在此联系人上查看注释。 

 ·红色箭头表明可选择的联系方式是存在的。按 F2 键或右击

该联系人，选择 Contact > View Alternate Numbers with 

Presence。 

3 默认状态下，我可以看到 the Cisco Unified 

Attendant Console 电话薄下的所有联系人。这就使

得我可以创建个人电话薄群组，可以快速地将不同

组的联系人分开。如果你配置有过滤器的话，这些

群组就会随着用户自动更新。 

强调：个人电话薄群组对于创建者而言是私人的，

是不能被其他操作员看到或分享的。这些电话目录

群组是整个电话薄的子系统，与 Cisco Unified 

Communications Manager 是同步的。由于个人电话

薄群组在创建时使用了现时的电话薄过滤器，并通

过拖拽个体联系人的方法，所以操作者可以加密群

组并经常更新。 

·右击电话薄窗口的任何位置，选择 Personal Directory Group > New. 

·在 Name 区，给群组命名为 My Engineering Group. 

·在 Description 区域，将 Engineering 作为说明或产品描述。 

·在 Filter 区域，选择 Field 下的 Department，选择“等于”并将属性设

置为 Sales。 

·点击 OK，创建一个新组。 

·新组将会在电话薄窗口以一个新标签的形式显示。 

注：你也可以手动操作在群组中添加联系人，即通过从全部电话薄将

联系人拖拽到个人电话薄群组中。 
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步骤 要点 操作 

4 作为操作员，我也可以在 Attendant Console 中创

建快速拨号。这使得我可以选择存在于 Attendant 

Console 中但不属于 UCM 终端用户的联系人。 

我可以创建私人快速拨号，即其他操作员都看不见

或全球快速拨号，即所有操作员可见 

·右击快速拨号区域的任何位置，选择 Add Speed Dial. 

·在 Number 区，输入任何电话号码 

·在 Name 区，输入联系人姓名 

·在 Company 区，输入公司名 

·选中私人快速拨号框，创建操作员的私人条目 

·点击 OK 

·点击 Yes 

注：如果你想验证一下快速拨号是否可用，按照演示的拨号模式，输

入一个工作的手机号码，然后双击该条目拨号。 

5 在我的业务中，第一时间快速准确的确定呼叫人至

关重要。 

通过 Cisco Unified Attendant Console，我有两种

方法来明确用户可得性的可见性。通过这两种方

式，我可以对是否转接电话或是否查找一个可选择

的联系人做出正确决定。 

Cisco Unified Attendant Console 为每个人整合了

Cisco Jabber、CUP, Microsoft OCS 或 Microsoft 

Lync，这使我能够看到用户在或不在的信息，不去

打扰那些自定义离开的用户。 

同时我也能够看见联系人电话的示忙指示灯区域的

状态，这是一个联系人电话的实时状态，可以看见

电话是闲置，在电话上，转接或者设为请勿打搅。 

 

·在工作站 1，选择 Full Directory 标签 

·使用搜索框中的 Last Name，输入名 Perez，你会看到信息显示

Anita 处于离线状态。 

·在工作区 2，启动 Cisco Jabber，你就会作为 Anita Perez 自动登录 

·在工作站 1，提示信息就会变成绿色，显示在线 

·在 Cisco Jabber 上将状态改 Cisco Jabber 为不要打扰，然后观察在

电话目录里有何变化 

·更改 Cisco Jabber 上的自定义信息，将鼠标悬停在 Attendant 

Console 内的联系人上，观察显示的信息 

·将 Anita 的台式电话摘机，注意电话上显示图标的变化。 

 

6 
通过 the Cisco Unified Attendant Console，我有了一

个新队列（任务列表），可以帮助我确认我所接到

的所有电话类型，进而是我可以以不同的方式回

复。我有一个内部队列、外部队列和语音邮箱突破

队列。 

每个队列都可以由它们各自的电话传递方式配置。 

广播传递可以通过 PC 应用程序将电话呈现给所有的

操作员；在这个点上呼叫是按顺序响起的，（它使

用 PC 扬声器来发出一个通知声音），这时在电话上

并未接收到呼叫信号。 

被迫传递将会迫使最高的优先呼叫从队列中出去，

将呼叫信号传递到操作员的电话上。如果这个操作

员在 10s 内没有接听电话，电话就会传递给其他操

作员。 

（请注意该演示系统是将队列设定在广播传递上

的）。 

各队列也可以由其溢出目的地配置。若没有操作员

登录或呼叫等待时长、队列中的呼叫数量多或出现

了紧急情况，电话就会溢出（超限）。这些溢出的

目的地可以是通过 CUCM 拨号的任何目的地。 

 

在工作站 1，配置队列： 

·启动网络浏览器 

·在 dCloud 主页，选择 Collaboration Admin Links > Cisco Unified 

Enterprise Attendant.  

·通过以下认证登录：用户名：ADMIN ，密码: C1sco12345. 

·导航至 User Configuration > Queue Management 

·点击 查找 

·点击 选择外部队列 

·注意外部队列配置的溢出设置。 

注：不要更改 DDI 号码，不要与 CUCM 同步。被迫传递选择仅在创建

一个队列的时候可用，队列一旦创建就不可更改，所以创建队列后这

个选项区域是灰色的。 
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步骤 要点 操作 

7 
每个队列都可以由其优先顺序配置。这就意味着该

系统可以根据队列优先顺序对呼叫电话进行自动排

序，如果队列中的优先顺序是一样的，那么就会回

应等待时间最长的呼叫。 

称谓也是可以被配置的，这帮我弄清楚该如何接听

电话。如果某一称谓配置给一队列，那么在我接听

那个队列之外的电话时，这个称谓就会突然出现。

这确保我可以合适地接听电话。 

 

·返回到队列管理页面，选择内部队列 

·注意将内部队列的优先值设为 50 

·返回到队列管理页面，选择外部队列 

·注意将外部队列的优先值设为最低值 99 

·依照现在设定的优先值，来自内部队列的呼叫将会比来自外部的更

有优先权。 

·将外部队列的优先值调整为 25 

·注意每个队列中定制的称谓 

注：不要更改 DDI 号码，不要与 CUCM 同步。 

8 这个序列可以将不同的操作者联系起来。这意味

着，这个系统可以以某种方式将来电区分开来，以

至于不同的操作者只能看到某一个来电。 

下面举一个例子，一个拥有两个办公场所的公司

（办公室 A 和办公室 B）。每一个位置的操作者应

该只能看到属于他们位置的电话。使用 Cisco 

Unified Attendant Console ，我可以很容易地将相

关的序列分配给相关的操作者。 

 在 Cisco Unified Attendant Console 菜单中选择 User 

Configuration，后在选择 Opreator Management. 

 点击 Find。 

 选择用户 OP1，看相关的来电序列。 

9 作为操作者，及时地接听电话为消费者服务是十分

重要的。 

当电话呈现在屏幕前时，电话应该被系统按重要程

度进行排序。  来电应该显示在 Queued Calls 

Area (F8)上，按优先权的降序来排列。     使用

ANSWER  NEXT，我们就可以按照系统设定的优

先权顺序来接听电话。   排在最优位置的来电将会

被首先接听。 

使用 Cisco Unified Attendant Console，我们可以

用多种方法接听电话，比如键盘或者鼠标。 

 

重点：大部分的操作任务可以用以下四种任务中的

一种进行完成：运用键盘快捷键；将电话从一个区

域拖至另外一个区域；右击功能键；运用 CALL 

CONTROL 这一图标。 

 

 通过在演示机上拨 DN 7600，可以将一个来电放入内部队列

中。 

 等几秒钟，然后从另一个设备拨和ＤＮ 7800 关联的 DID 号

码将来电放进外部序列。 

 在先前的步骤中，外部序列比内部序列享有比较高的优先

权。因此，即使内部来电首先响起，外部序列的来电也将会被放

置序列的最顶端进行接听。 

注：如果序列的优先权是一样的，那么来电将会以它们来时的顺序进

行接听。 

 按“＋”键对序列中下一个最高优先权来电进行接听。 

 一旦你接听电话，一个关于Ｓａｌｕｔａｔｉｏｎ的弹出对

话框将会显示出来。 

 结束来电. 

 生成另外的来电并且说明每一种接听的方法：双击来电；将

来电从Ｆ８拖至Ｆ７；右击 Queued Calls Area (F8) 选择Ａｎｓ

ｗｅｒ ｎｅｘｔ。 
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步骤 要点 操作 

10 作为一个繁忙的操作者，同一时间处理大量的电话

是十分重要的。 在某些情况下，我能够很快地接

听电话并且挂起（on hold)，用这种方法这些来电

被接听而不是继续等待。 

 

我也可将电话挂起（on hold），如果远方的用户正

忙或者在另一个电话上，或者他们的 Jabber 状态显

示他们不可用。 

有时，当我暂停已接听的电话时，我需要做一个注

释，我可以运用键盘或者鼠标做这件事情。 

 

在演示机上拨ＤＮ 7600，可以将一个来电放入内部序列中。 

请按“＋”接听下一个优先权比较高的来电。 

按Ｐａｇｅ Ｄｏｗｎ键可以将电话设置成处于繁忙状态，这样的话

来电将会从Ｆ７区域转至Ｆ５区域。这个命令可以使操作者能够接听

下一个来电。 

注：通过右击，选择Ｈｏｌｄ命令，将来电从Ｆ５区域拖至Ｆ７区域

或者选择电话控制工具栏下的Ｈｏｌｄ Ｃａｌｌ图标都可以将电话

转至成繁忙状态。 

拨和ＤＮ 7800 相关联的 DID号码可以将来电放入外部序列。 

请按“＋”接听下一个优先权比较高的来电。 

从电话录中选择一个用户，运用上述几种方法就可以将电话设置成繁

忙状态。 

电话处于繁忙状态；在Ｆ５区域的信息表明谁的电话被搁置了。这样

的话，你就可以知道他们的电话什么时候可以被接听。 

结束电话。 

形成另外的来电并且说明使电话处于繁忙状态的每一种方法：按Ｐａ

ｇｅ Ｕｐ键；右击，并且选择Ｈｏｌｄ ｗｉｔｈ Ｎｏｔｅｓ在

电话控制工具栏中选择ｈＯＬＤ Ｗｉｔｈ Ｎｏｔｅｓ． 
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步骤 要点 操作 

11 快速地转移电话是十分重要的。一次就将电话快速

地转移给正确的人，对于我们的工作来说是十分重

要的。 

 运用 Cisco Unified Attendant Console，我可以混

合使用忙线转移和咨询转移技术来转移电话给电话

簿里的人，输入的号码，快速拨号，或者到联系人

的可选择的其他号码。运用 Blind Transfers，我可

以在不用和接听者通话的情况下将电话送至目的地

。 

如果我需要和接听者通话告知拨打者的信息，我可

以使用咨询转移。 

我也可以使用相同的转移方法针对于快速拨号，可

选择的号码或者 1 个我输入的号码 

o 在 Attendant Console 菜单中, 选择 Options > 

Preferences > Call Transfers. 

o 描述选项。当拖或者双击时，用户可以设置控制台

来执行 Blind Transfers 或者 Consultation Transfer 

o 在演示机中拨 DN 7600，将电话置于内部序列、 

o 接听电话。 

o 在电话录搜索区域寻找想要联系的人。 

o 说明执行 Blind Transfers 的方法：双击 contact；

拖来电至 contact 中；右击选择 Blind Transfers 命令。 

o 在演示机中拨 DN 7600，将电话置于内部序列、 

o 接听电话。 

o 在电话录搜索区域寻找想要联系的人。 

o 按 enter 键一次使用户置于繁忙状态，给目的地一

个电话。 

o 说明如何 Consultation Transfers 给联系人：按“+”

，右击选择转换命令或者选择转换图标进行不同用户之

间的切换；取消 Consultation Transfers，按“-”键，右击

选择清除按钮或者在电话控制工具箱中清除图标；完成

转换命令，再次按 enter 键，右击选择完成转移选项或

者选择转移电话图标。 

o 转移给其他号码：为了转移给一个可选号码，当联

系人被选定时按 F2 键，使用其中一种方法来转移电话

到窗口底部列出的可选号码。若要转移到一个不存在于

电话簿得号码时，输入那个号码然后按 Enter 键两次。 

 

12  

有时，转接的电话可能没被接听。这种情况下，电

话会返回来，这样的话我可以将电话转移给其他位

置。 

 

存在这样的情况：我将电话转接给错误的人；这

时，使用系统，我可以轻松地撤回电话，当然是在

电话没有被接听的情况下。 

 在演示机中拨 DN 7600，将电话置于内部序列、 

 接听电话。 

 在电话录搜索区域寻找想要联系的人。 

 在电话录中对一个用户执行 Blind Transfer。 

 不接听电话，但是要按 ctrl 和 r 键撤回电话。 

 再次转移电话。不要在目的地接听电话。30 秒后，电话会

转接至语音信箱。 

13 我们的一些联系人有随时离开座位的需要，让这些

移动用户接到电话是十分重要的 

运用 Cisco Unified Attendant Console，寄存一个

用户的电话对于我来说是十分容易的。之后用户可

以用任何一部电话拨这个电话寄存号码，取得与拨

号人的联系。 

 在演示机中拨 DN 7600，将电话置于内部序列、 

 接听电话。 

 按 home 键，右击选择寄存电话或者在电话控制工具栏中选

择寄存电话的图标，寄存一个电话。 

 电话从 F7 区域转移至电话寄存区域，图标中的一个会从黑

色变为绿色，记下寄存电话的分机号码 

 从另一部电话给电话寄存号码打电话，这样就可以和拨号人

建立通话 



  

 
© 2013 Cisco and/or its affiliates. All rights reserved. This document is Cisco Public Information. Page 9 of 13 

步骤 要点 操作 

14 知晓有多少电话被 Attendant Console 处理是很重

要的。这决定着需要多少个操作者。 

 启动 IE 

 打开 dCloud 主页, 选择 Collaboration Admin Links > Cisco 

Unified Enterprise Attendant. 

 用以下信息登陆: 用户名: ADMIN；密码: C1SCO12345. 

 在 Navigation 菜单中使用 下拉菜单并且选择 Cisco Unified 

Reporting 后单击 Go.  

 单击 System Reports. 

 选择 Operator Calls by Queue 报告. 选择 the External 和 

Internal queues for OP1 然后 Generate Report. 

 这份报告可以被打印或者被导入 excel 或者 pdf 文档。 

 显示其他的报告和一些可用的参数。 
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场景 2: Cisco 紧急应答 

这个场景解释了 Cisco Emergency Responder 是如何起作用确保 Cisco Unified Communications Manager 将紧急的电话传给合适

的 Public Safety Answering Point (PSAP) ，这个 PSAP 与来电者处于同一区域，并且 PSAP 可以识别来电者的位置, 如果需要的

话, 返回电话. Cisco Emergency Responder 可以告知现场紧急安全员一个紧急事情正在发生，以及他的具体位置。 

注：在此演示中，Charles Hollan 用户充当 911 接线员。系统配置为从 911 号码 呼叫 Charles Hollan 的分机，以便模拟的 911 电话

不被转入真正的应急响应程序。不建议在本演示中的步骤以外呼叫 911 。 

 

演示步骤; 

步骤 要点 操作 

1 我是 Adam McKenzie ，除了作为 控制台操作员外

我还可以作为报告现场安全的人员。 

使用 Cisco Emergency Responder，我可以得到我

需要识别和需要帮助的人的信息。并且我需要引导

火警，警察，救护车服务，因为我能够确认有情况

的位置。 

让我们先看一个例子 

 工作站 1 

 登陆 Outlook：用户名为 amckenzie，密码为 C1sco12345

。 

 启动 Cisco Jabber. 你可以以 Adam McKenzie 的身份自动

地登陆. 

 使用桌面快捷键启动 Attendant Console . 

 选择 File > Login ，输入用户名 OP1 和密码 C1sco12345. 

 点击登陆。 

注：确保 Numlk 是关着的。 

 工作站 2 

 启动 Cisco Jabber. 你可以以 Anita Perez 的身份自动地登陆
. 

 确保 Cisco IP 电话 6941 被注册到 Charles Holland 分机号

是 x6018. 

2 我们最近遇到这样的一种情况 Anita Perez 在办公

室出现了眩晕和呼吸障碍。她感觉这是一件严重的

事情，所以就拨打了 911 寻求帮助。 

她打电话给 911，说了他的症状的详细情况。但是

她不能提供她所处位置的准确的信息。 

当 911 电话开始的时候，除了追踪电话外，Cisco 

Emergency Responder 同时生成一个电话给我用于

与现场情况的联系。 

我们可以利用这些信息来确定她的位置，这些信息

是 anita 的电话的记录以及直接的紧急反应。 

 Anita Perez’s 9951 或者 Cisco Jabber 客户端, 拨打 911.  

 Charles Holland’s 6941（作为 911 接线员） 将会响起. 接听

电话。 

 同时一个电话将会生成并传给操纵台操作人员。 

 注：如果 Charles Holland 没有电话，你将会接听到一个事

先录制的信息。这不会影响总体的演示。工作站 1（以 Adam 

McKenzie 的身份），从操纵台的操作人员，接听电话，听紧急

情况的电话录音以及来电者的位置。 
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步骤 要点 操作 

3 作为一个额外的预防措施，Cisco Emergency 

Responder 被设置成当一个 911 被拨打的任何时间

都给我发送一封邮件。当我离开我的办公桌时，这

份邮件是无价的，因为我可以经常从我的手机中收

发邮件。 

邮件信息本身具有一些信息，利用这些信息，我可

以识别来电者的位置等。 

但是，如果我需要 anita 的额外的其他详细信息，

我可以打开邮件所提供的连接，去看 CER 的具体的

信息。 

每一个电话记录都包括 ELIN。ELIN 号码被分配到

被一个转换以及每一个位置中，ELIN 数字被 911 操

作者用来识别电话来自于哪个地方。  当电话被挂断

时或者邮件没有形成时，这时十分有用的。 

 我可以拨这个和紧急联系人联系。 

这个界面允许我获得每一个紧急电话来确保每一个

意外事件都可以被处理。 

 工作站 1（以 Adam McKenzie 的身份）  

 从 Outlook Inbox,在 inbox 中打开 CER 文件夹. 

 从 CER 文件夹中, 打开来自于 CER 的邮件。这个信息包含

来自于 anita 拨打 911 电话的信息。  

 打开包含于邮件信息的超链接。 

 登陆 Cisco Emergency Responder ，用户名 amckenzie ，

密码 C1sco12345. 

 从电话清单中，选择你为这个样本制作的电话。点击 call 

time 连接，打开电话记录。 

 找出电话记录中包含的额外的信息，比如建筑号码，街道号

码等等。 

 关闭弹出窗。 

 点击 acknowledge 连接，表明处于紧急状况的人已经被帮助

了。 

 点击 ok。 

 当接收到电话后，这个页面就会被刷新。 
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附录 A：注释以及替代方法 

1.默认情况下，BLF 电话状态不会在演示环境下工作。要看 BLF 的状态，需要为每一个电话添加 MAC 地址。a。对于一个指定的用

户，执行电话录搜索。b。按 F12 键，打开 contact 的详细信息。c。选择 contact numbers。d。选择 User device name 工具箱，输

入用户电话的 MAC 地址。 

注：MAC 地址应该以 SEPXXXXXXXXXXXX 这样的形式输入。 

2.如果所以用户呈现的状态不能正常工作。a。打开 Options > Preferences > Presence. b。为 Cisco Presence Status 选择录音按钮, 

然后点击 OK. 

3.如果你接收到任何一个关于 CUACEE 号码的快速繁忙的声调，重启 CUACEE 服务。a。在任一演示工作站中启动 Internet 

Explorer 并且浏览 Collaboration Admin Links > Cisco Unified Enterprise Attendant Console.  

b。用以下信息登录。用户名: ADMIN, 密码 : C1sco12345.  

c。从菜单栏中选择 Engineering > Service Management ，后为 Cisco Unified Attendant Server 选择停止图标。点击 ok。  

d。点击开始按钮重启这个服务，点击 ok。 

4。如果 BLF 状态不正确的话，你可能需要添加其他的调控电话。 

a。启动 Internet Explorer ，从 the Cisco Demo dCloud 主页打开 Collaboration Admin links > Cisco Unified Communications 

Manager.  

b。用以下信息登陆，用户名 administrator, 密码: C1sco12345.  

c。从菜单中选择 User Management > Application Users.  

d。搜索用户 cueac. 

e。点击 find more phones 并且选择你需要监控的电话。 

f。点击 Add Selected 保存改变.  

g。退出并且再次登入 Attendant Console 那么这时 BLF 将会呈现。 

5.由于你的副本到期了，你需要更新通行证，重新启动 CUEAC。 

a。使用 RDP 或 WebRDP 连接到 CUEAC 服务器 198.18.133.9 

b。用 Administrator 的身份以及 密码 C1sco12345 进行登陆. 

c。打开 Start > Restart. 

d。当提示输入建议时，输入任何内容点击 OK 

 

 

附录 B：额外的解决方法 

Cisco Unified Attendant Console 有很多版本可以使用，并且有很多的附加功能特征。这些东西不属于本次演示的一部分。要想获得

关于版本和特征的各种信息，请参考一下链接：http://www.cisco.com/en/US/products/ps7282/products_data_sheets_list.html 

 

你也可以观看以下 终端用户培训视频 http://www.arcsolutions.com/north_america/solutions/products/cisco_oem_consoles.aspx 
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